
The User Interface

Click when you see a  to get an explanation.



Undo the last action to the image.



Deletes the image.



When you click on this toolbar button, a popup menu appears. You can use the commands on the popup 
menu to move/copy/rename the current image.



Shows or hides the file browser.



Displays the Open With menu.



This is the image window (the display area). All images will be displayed here.



How long time it took for IceView 95 to load the image, in seconds.



How many images the current folder contains, and which number the current image has.



The image's size and number of colors.



The current zoom level (the percentage of the image's actual size).



The image's format.



This is the IceView 95 titlebar. Double-clicking on the text display section of the titlebar switches the 
IceView 95 window between its maximized and normal states. The current image's filename is displayed 
here.



Reduces the window to an icon. The keyboard shortcut for minimizing the window is SHIFT+ESC.



Enlarges the window to fill the screen. When the window is maximized, the Restore button appears. The 
Restore button returns the window to its last non-minimized, non-maximized position.



Closes IceView 95.



This is the System menu.



Opens an image. Locate the image to open using the resulting dialog box.



Saves the image.



Prints the image. 



Sets the image as the new desktop wallpaper. 



Copies the image to the clipboard.



Inserts the clipboard contents into the image window.



Displays the previous image in the list.



Displays the next image in the list.



Starts or stops a slide show.



Enlarges the apparent size of the image.



Reduces the apparent size of the image.



Displays the image in full screen. Hit the ESC key or the Enter key to return to the window.



Displays information about the image. 



Changes various categories of IceView 95 options.



Displays the help contents.



How many files the current folder contains and the total size of these files. 



The selected file's size, and the date when it was created or last modified.



This control displays a hierarchical list of the folders on your hard drive. Double-click on a folder to 
change into it. To move up one folder, press the Backspace key.



This control lists the files in the current folder. Simply click on an image to display it in IceView 95. To 
refresh the list of files and folders, press F5.



This control displays a list of all the valid drives in your system.



This is the file browser's titlebar. The selected file's name appears here.



Click here to hide the file browser.



General Options

Keep browser on top
If this is checked, the file browser is always on top of all other windows, even when it's not the active 
window.

Save window settings on exit
If this is selected, IceView 95 saves the size and position of the IceView 95 and file browser windows on
exit and restores the size and position at startup.

Display splash screen at startup
If this option is selected, a splash screen will be displayed at startup. Check this option to stop the 
splash screen from displaying.

Show scroll bars in full screen
If checked, scroll bars will be displayed in full screen mode. If not, you can still scroll the image by 
dragging it around with the mouse.

Use flat toolbar
Checking this option makes the toolbar flat.

Ordered
Select this to use ordered dithering to enhance the display of high color and true color images on a 256 
color display.

Error diffusion
Select this to use error diffusion to enhance the display of high color and true color images on a 256 
color display.

Note: Ordered dithering is faster than error diffusion, but the quality of the image is not as good.

Background color
Click on this to change the background color of the IceView 95 image window.

Zoom factor
Determines which zoom factor the image will have when it is loaded.

Full Page
Displays the image so that it fills the window in at least one direction.
Best Fit
Makes sure the image will fit on the screen but will not stretch the image.
25% 1:4 Zoom
50% 1:2 Zoom
100% 1:1 No zoom
200% 2:1 Zoom
400% 4:1 Zoom
600% 6:1 Zoom

Right mouse button displays
This option specifies what to display when right-clicking on the IceView 95 image window.

Disable Undo
When this option is selected, IceView 95 does not save any undo information and the Edit/Undo 
command will be disabled. It may be a good idea to turn this option on if you are working with very large
images, since it takes up pretty much RAM to save the undo information.





File Options

Confirm delete/overwrite
Select this option if you want IceView 95 to ask for confirmation before deleting or overwriting a file.

Delete files to recycle bin
If this option is selected, files will be deleted to the Windows recycle bin. If not, files will be deleted 
permanently.

Display progress
Checking this option makes IceView 95 display progress in file operations that takes longer than a few 
seconds to complete.

Rename on collision
If the destination file already exists when moving or copying a file, give the source file a new name that 
is unique in the destination folder.

Automatically load images
Select this to load images as they are selected in the file list. If this option is turned off, you have to tap 
the Enter key to view the selected image.

Decrease to 256 colors on load
Check this to have IceView 95 decrease images to 256 colors when they are loaded. This is useful if 
your graphics card only supports 256 colors.

Show hidden files
If selected, hidden files will be displayed in the browser's file list.

Single click opens folders
If selected, a singe click on a folder in the file browser directory list will open it. If not, you will have to 
double-click.

Show full path in titlebar
If checked, the full path name of the file will be displayed in the IceView 95 titlebar. If unchecked, only 
the filename will be displayed.

Show path first in titlebar
When checked, the path is displayed prior to the IceView 95 name in the titlebar of the IceView 95 
window. Otherwise, the current directory is displayed after the IceView 95 name in the titlebar.

Ignore Photoshop files
Unfortunately, you will end up with a GPF (general protection fault) if you try to open a Photoshop 4 file 
in IceView 95. If you are browsing through a folder containing Photoshop 4 files, select this option and 
IceView 95 will not try to display any Photosop files, preventing IceView 95 from crashing.

Start-up folder
When IceView starts up it will change to a folder of your choice. Files in this folder are automatically 
displayed in the file browser and in the Open dialog box.

Last accessed 
Starts up in the folder last accessed from the previous session.
System default
IceView 95 does not change folders. Usually this is the folder containing ICEVIEW.EXE
Folder 
IceView 95 always changes to the specified folder. Click on the … button to browse for a folder to use.





Slide Show Options

Sequence
This option determines the sequence in which to display images in a slide show.

Delay
Pause for this many seconds in a slide show before showing the next image.

Music
Specifies whether slide shows should be accompanied by music.

No music
No music will be played during slide shows.
Play audio CD
Plays an audio CD in the background. Enter the track that the CD should start at in the text box.
Play a midi file
Plays the specified midi file.
Play a wave file
Plays the specified wave file.

Display slide show in full screen
If this is selected, slide shows will be displayed in full screen mode. Close the slide show by pressing 
ESC, Enter or the right mouse button. Note: Slide show scripts are always played in full screen mode.

Hide mouse cursor
Check this to have IceView 95 hide the cursor in a full screen slide show.

Disable screensaver
If checked, then screen saver activation will be disabled during a full screen slide show.

Default Script Folder
Determines the default script folder.



Associations

The Associations tab allows you to select the file types that will be associated with IceView 95. By 
associating a file type with IceView 95, you can open the image by double-clicking on it at any time. If a 
file type is not checked, IceView 95 will ensure it is not associated with that extension. 

To select all file types, click on the Select All button. If you do not wish to have any file types associated 
with IceView 95, click on the Select None button. 

Icon for Explorer
Enables you to select an icon to use for image files. Type in a path to an icon or click on the … button to
browse for an icon. If no icon is selected, the IceView 95 icon will be used.

Explorer shell extension 
This checkbox determines whether the IceView 95 Explorer context menus are enabled. The context 
menus allows you to right-click on a folder in Explorer and select Browse with IceView 95, IceView 95 
will then start up in the folder you right-clicked on. You can also right-click on an image in Explorer and 
select View to view images.



Image Index Options

Beep when done
Whether IceView 95 should beep after the image index has been created. This is useful if you have 
minimized IceView 95 during the creation of the image index, and you want to know when it's done. 
Note: IceView 95 will only beep if the window is minimized.

Show filenames
Check this to display filenames in the image index.

Show image resolutions
Check this to display image resolutions and the number of colors.

Thumbnail size
Determines how big each thumbnail will be, in pixels.

Background color
Determines the background color of the bitmap IceView 95 creates when making an image index. 

Border color
Determines the border color of the rectangle surrounding each thumbnail. 

Fill color
Determines the color of the rectangle surrounding each thumbnail. 



GIF Window Options

Keep on top
If this is checked, the animated GIF window is always on top of all other windows, even when it’s not 
the active window.

Hide when minimizing IceView 95
When this options is checked, IceView 95 will hide the animated GIF window when you minimize 
IceView 95, and show it again when you activate IceView 95. If unchecked, the animated GIF window 
will remain visible.

Display frame numbers
Check this to have IceView 95 display frame numbers in the animated GIF window.



Open With Options

Helper applications for the "Open With" menu
A list box containing up to 10 applications. The defined applications will appear in the Tools/Open With 
submenu. Selecting an application from the submenu will send the current image to the application.

Click on the Add button to add an application to the list. Click on the Edit button to edit an entry. The 
Remove button removes an entry.



Shortcuts

Include IceView 95 on the desktop
If this checkbox is selected, a shortcut to IceView 95 is added to the desktop. Uncheck this option to 
remove the IceView 95 shortcut from the desktop.

Include IceView 95 in the start menu
If this is option selected, IceView 95 is automatically added to the taskbar start menu. Uncheck this 
option to remove IceView 95 from the start menu.

Include IceView 95 in the send to menu
If this is option selected, IceView 95 is automatically added to the send to menu. Uncheck this option to 
remove IceView 95 from the send to menu.



Contacting Mithril Software

E-Mail support@mithril.d.se

WWW http://www.mithril.d.se

FAX +46 16 70794

Telephone +46 16 73106 or
+46 16 73006

Post Mithril Software
Skogshall
635 20 Eskilstuna
Sweden

If you think of any new features you'd like to see, or have any problems, comments or questions, please 
feel free to contact Mithril Software.



IceView 95 License Agreement

Registered Version

One registered copy of IceView 95 may either be used by a single person who uses the software 
personally on one or more computers, or installed on a single workstation used nonsimultaneously by 
multiple people, but not both.

You may access the registered version of IceView 95 through a network, provided that you have obtained 
individual licenses for the software covering all workstations that will access the software through the 
network. For instance, if 8 different workstations will access IceView 95 on the network, each workstation 
must have its own IceView 95 license, regardless of whether they use IceView 95 at different times or 
concurrently.

You may not reverse engineer, decompile, or disassemble IceView 95.

Shareware Version

Distribution

You may freely distribute the shareware version of IceView 95, provided that:

1. Such distribution includes only the original archive supplied by Mithril Software. You may not alter,
delete or add any files in the distribution archive.

2. No money is charged to the person receiving the software, beyond reasonable cost of packaging 
and other overhead.

Evaluation and Registration

IceView 95 is not free software. You are hereby licensed to use IceView 95 for evaluation purposes 
without charge for a period of 30 days. If you use this software after the 30 day evaluation period a 
registration fee of $20 US is required. Unregistered use of IceView 95 after the 30 day evaluation period 
is in violation of U.S. and international copyright laws.

Disclaimer of Warranty

This software and the accompanying files are provided "as is" without warranties as to performance of 
merchantability or any other warranties whether expressed or implied. No warranty of fitness for a 
particular purpose is offered. The entire risk arising out of use or performance of IceView 95 remains with 
you. In no event shall Mithril Software be liable for any damages whatsoever (including, without limitation, 
damages for loss of business profit, business interruption, loss of business information, or any other 
pecuniary loss) arising out of the use or inability to use IceView 95.



Keyboard Shortcuts
Shortcut Function
CTRL+0 Open
CTRL+L Close
CTRL+R Reload image
CTRL+S Save as
F7 Move to
F8 Copy to
Delete Delete
SHIFT+DEL Delete permanently
F2 Rename
CTRL+G Go to folder
F3 Search
CTRL+P Print
CTRL+Z Undo the last action
CTRL+C Copy image to clipboard
CTRL+V Insert the clipboard contents
CTRL+F or Enter Full screen
CTRL+A Actual size
NUM+ Zoom in
NUM- Zoom out
SHIFT+I Interpolated zoom
Space or Page Down Next image
Backspace or Page Up Previous image
Insert Random image
Home First image
End Last image
F5 Stop/resume slide show
F9 Slide show editor
CTRL+INS Play slide show script
CTRL+I Image information
F6 Build image index
F12 Show or hide the file browser
F4 Play animated GIF
CTRL+W Desktop wallpaper, centered
CTRL+T Desktop wallpaper, tiled
ALT+W Remove the desktop wallpaper
CTRL+E Send image to first Open With app
SHIFT+F6 Thumbnail viewer
ALT+O Options
F1 Help contents
ALT+X Quit
NUM 8, 2, 4, 6 Scroll image (up, down, left, right)
CTRL+N Create a new instance of the program
SHIFT+ESC Minimize window

You can use the following shortcuts within the Browser:

Shortcut Function
Backspace Move up one folder
F5 Refresh the list of files and folders
Enter View the selected image
F12 or ESC Hide the file browser
ALT+X Quit



Overview of Features

· Support for 30+ image formats, including animated GIF images
· File-management tools
· Full screen and windowed slide shows, with forward/reverse/random sequencing options
· Scroll and zoom
· Rapid image decoding
· Image manipulation
· Screen capture support
· OLE drag and drop
· Thumbnail viewer
· Set the desktop wallpaper to any image
· Ability to change the Windows startup and shutdown screens
· Extensive image information
· Ability to build image thumbnail indexes
· User configurable toolbar
· A lifetime of free IceView 95 upgrades for registered users!



Supported Image Formats

· JFIF - JPEG File Interchange Format.

· JTIF - JPEG Tagged Interchange Format.

· GIF - This is the Graphics Interchange Format created by CompuServe for storing and 
exchanging color raster images. This format compresses its image data with the LZW 
compression technique.

· Animated GIF - This is a multipage GIF format that can be played as an animation by displaying 
the images sequentially.

· Truevision TGA (TARGA) - This is a file format created by Truevision Inc. IceView 95 supports 
all uncompressed and RLE compressed TGA file formats.

· PNG (Portable Network Graphics) - This is a replacement for the GIF format. It is a full-featured
(non-LZW) compressed format intended for widespread use without legal restraints.

· TIFF - This is a tag-based file format designed to promote universal interchanges of digital image 
data. Because TIFF files do not have a single way to store image data, there are many versions 
of TIFF. IceView 95 supports the most common TIFF formats.

· MPT - This is a multipage TIFF format that enables a file to contain more than one image. It is 
handled the same as a regular TIFF file, except for the multipage feature.

· TIFF LZW - These files use the Tagged Image File Format with LZW compression

· TIFF CCITT - These are compressed TIFF files that are commonly used for FAX transmission 
and document imaging.

· TIFF CCITT Group 3 - These are TIFF CCITT files in a format that is more advanced and more 
compressed than TIFF CCITT. IceView 95 supports both 1-dimension and 2-dimension variations
of this format.

· TIFF CCITT Group 4 - These are TIFF CCITT files in a format that is more advanced and more 
compressed than TIFF CCITT Group 3.

· IOCA (ICA) - This is the Image Object Content Architecture developed by IBM. IceView 95 
supports these files in an MO:DCA wrapper with embedded 1-bit CCITT Group 3 or Group 4 
images. IceView 95 also supports IOCA files without an MO:DCA wrapper.

· WinFax Group 3 - This is a FAX format created by Delrina for Group 3 support.

· WinFax Group 4 - This is a FAX format created by Delrina for Group 4 support.

· FAX Group 3 - This is a raw FAX format (without a header) for Group 3 support. IceView 95 
supports both 1-dimension and 2-dimension variations of this format.

· FAX Group 4 - This is a raw FAX format (without a header) for Group 4 support.

· Photoshop 3.0 (PSD) - This is the format produced by the Adobe Photoshop graphics editor. 

· Windows Bitmap (BMP) - This is a file format created by Microsoft. Some BMP images are 
compressed with an RLE type compression.

· Windows Metafile (WMF) - These files are not bitmap based images. A Windows metafile 
consists of a collection of device independent functions that represents an image. When a 
program loads a metafile, these functions are executed to obtain the image.

· PCX - This is a file format created by ZSoft. This format compresses its image data with the RLE 
type compression.



· DCX - This is a multipage PCX format that enables a file to contain more than one image. It is 
handled the same as a regular PCX file, except for the multipage feature.

· PostScript Raster (Encapsulated PostScript) - These files are used primarily on PostScript 
printers. These printers usually offer more variety of fonts and higher resolution than standard 
laser printers. EPS files will work on any PostScript compatible printer and any end user 
application that supports placement of EPS files in its work space.

· OS/2 Bitmap (OS/2 BMP) - These are files created on an OS/2 operating system. IceView 95 
supports both 1.x and 2.x formats.

· CALS Raster - These are 1-bit CCITT Group 4 CALS raster files. CALS is a United States 
government standard.

· MacPaint (MAC) - These Macintosh Paint files are commonly used for monochrome clip art.

· GEM Image (IMG) - These files are native to the Graphical Environment Manager developed by 
Digital Research.

· Microsoft Paint (MSP) - These files from early versions of Windows are used for black-and-white
drawings and clip art.

· WordPerfect (WPG) - These are WordPerfect raster files.

· SUN Raster (RAS) - These files are native to Sun UNIX platforms.

· Macintosh Pict (PCT) - These files, produced using Macintosh QuickDraw, are used in desktop 
publishing and imaging applications.

· LEAD - This is the LEAD CMP compressed format for grayscale and color images

· LEAD 1BIT - These are 1-bit LEAD compressed files.

· PCD - These are Kodak Photo-CD files.



The File Menu

Open
Opens an image. Locate the image to open using the resulting dialog box.

Close
Closes the image.

Reload
Reloads the image. Any changes will be lost. You can also double-click on the leftmost panel on the 
status bar to reload the image.

Save As
Saves the image.

Move to
Moves the image to a different drive or folder.

Copy to
Copies the image to a different drive or folder.

Delete
Deletes the image.

Note: You can determine whether IceView 95 should display a confirmation dialog to avoid accidental 
deletion in the options dialog box, files tab. You can also determine whether files should be deleted to 
the recycle bin or permanently.

Rename
Renames the image.

Create Folder
Creates a new folder within the current folder.

Go to
Displays the Go to Folder dialog. It allows you to go directly to the specified folder.

Search
Presents the Search dialog box which allows you to search a drive for a specific file or for folders 
containing images.

Print Setup
Displays the Print Setup dialog box which you can use to change the configuration settings for your 
printer.

Print
Prints the current image.

Exit
Closes IceView 95.



Move to Dialog Box

1. Type in a destination path, select one from the recently used list, or click on the Browse… button. 
If you enter a path that doesn't exist, it will be created for you.

2. Click on the OK button to move the image to the destination folder.

The Remove button removes a path from the history list. The Remove All button removes all paths from 
the history list. If you want to move more than one file, click on the Add Files… button and select which 
additional files to move.



Copy to Dialog Box

1. Type in a destination path, select one from the recently used list, or click on the Browse… button. 
If you enter a path that doesn't exist, it will be created for you.

2. Click on the OK button to copy the image to the specified folder.

The Remove button removes a path from the history list. The Remove All button removes all paths from 
the history list. If you want to copy more than one file, click on the Add Files… button and select which 
additional files to move.



Rename Dialog Box

1. Enter the new filename.
2. Click on the OK button.

Note: You will be asked for confirmation if you are changing the image's filename extension.



Create Folder Dialog Box

1. Enter the name of the folder that you want to create.
2. Click on the OK button.



Go to Dialog Box

1. Type in a path, select one from the recently used list, or click on the Browse… button.
2. To clear the recently used list, click on the Clear History button.
3. Click on the OK button.



Search Dialog Box

1. To find a specific file, select the Find this file option and then type the name of the file you want to 
find. You can use an asterisk (*) to represent any number of characters in a name you are unsure 
of. To find folders containing a certain number of images, select the Find all folders… option and 
enter at least how many images a folder must contain to be displayed in the Results list box.

2. Enter the path to where IceView 95 shall start the search, or click on the … button to browse for 
one.

3. Start the search by clicking on the Start Search button. 

4. To stop the search, click on the Stop button.

5. When IceView 95 has finished searching, select an item from the list box and click on the Open 
button. If you searched for a file, the selected file will be opened in IceView 95. If you searched for
folders, IceView 95 will change into the selected folder.



The Edit Menu

Undo
Reverses the last edit to the image. You can determine whether to save undo information in the 
options dialog box.

Copy Full Image
Copies the entire image to the Windows clipboard.

Copy Visible Image
Copies the image to the Windows clipboard just as it appears in the image window.

Paste
Inserts the clipboard contents into the IceView 95 image window.

Empty Clipboard
Emptys the data in the clipboard, freeing up memory.



The View Menu

Full Screen
Displays the image in full screen mode. Hit the ESC key or the Enter key to return to the window. You 
can display the next/previous image in full screen mode by pressing the Page Down/Page Up keys.

Actual Size
Displays the image's actual size. The image's actual size is when it's not zoomed.

Fit to Window
Displays the image so that it fills the window in at least one direction.

Zoom More
Increases the magnification.

Zoom Less
Decreases the magnification.

Interpolated Zoom
Turns the cursor into a crosshair selection tool, allowing you to zoom in on an area of the current 
image. A new image will be created from the contents of the defined area. The size of the new image 
will be the maximum size that can be created within the confines of the current viewing area.

IceView 95 will not simply rescale the image to display an enlarged version of the area of interest. An 
interpolation algorithm will be used to present as realistic an image as possible.

Next Image
Displays the next image in the file list.

Previous Image
Displays the previous image in the file list.

Random Image
Displays a random image from the file list.

First Image
Displays the first image in the file list.

Last Image
Displays the last image in the file list.

Run Slide Show
Displays the images in the current folder in a slide show.

Slide Show Editor
Presents a dialog box from which a list of images can be created for use in a slide show presentation.
You can get more information about the slide show editor by clicking on the ? button on its title bar and
then clicking on the object you want to know more about.

Play Script
Open and play a slide show script. Note that slide show scripts are always played in full screen mode.

Slide Show Options
Displays the slide show options.

Image Info



Displays information about the image. You can double-click on the right-most panel on the status bar 
to display image information.

Image Index
Builds an index of the images in the current folder. This is useful when exchanging images, and when 
you want to get an overview of all images in the current folder. See also: Image Index Options

Toolbar
Shows or hides the toolbar.

Status Bar
Shows or hides the status bar.

Scroll Bars
Shows or hides the scroll bars.

Browser
Shows or hides the file browser.



The Animation Menu

You can access all commands in the Animation menu by right-clicking on the animated GIF window.

Play
When an animated GIF image is loaded, the first frame is displayed in the IceView 95 image window. 
Choosing Play from the Animation menu, or pressing F4, starts the playback of the animated GIF 
image.

Stop
Stops the playback of an animated GIF image.

Frames
Displays a message box telling you the total number of frames in the animated GIF image.

Extract Frames
Presents the Extract Frames dialog box which allows you to extract individual images from animated 
GIF images. The extracted images will be saved as bitmaps into a folder of your choice.

Next Frame
Displays the next frame in the animated GIF image.

Previous Frame
Displays the previous frame in the animated GIF image.

First Frame
Displays the first frame in the animated GIF image.

Last Frame
Displays the last frame in the animated GIF image.

Close
Closes the animated GIF window.



Extract Frames Dialog Box

1. Select which frame(s) to extract.
2. Select a folder into which the images will be extracted.
3. Click on the OK button.



The Image Menu

Flip
Flips the image from top to bottom.

Mirror
Mirrors the image from left to right.

Rotate
Rotates the image.

Resize/Resample
Changes the image’s width and/or height.

Crop
Cropping an image is like cropping a photograph: you cut off one or more of the image edges, 
eliminating unwanted parts of the original graphic.When you have selected Crop from the Image 
menu, the cursor will turn into a crosshair selection tool. Point the crosshair at any corner of the area 
that you want to crop. Then press and hold the left mouse button and drag the cursor to the opposite 
corner of the area you want to select and then release the mouse button.

Add Text
Presents a dialog which allows you to add text to images.



Rotate Dialog Box

1. Select the direction of rotation. Right is clockwise, and left is counter-clockwise.
2. Select the degrees of rotation. 
3. Click on the OK button.



Resize/Resample

1. Select one of five standard image sizes, or a custom size.
2. If you want to maintain the relationship between the image's two dimensions, make sure the 

"Maintain aspect ratio" checkbox is checked.
3. Click on the OK button.

When you select Resample, the image is resized using interpolation and averaging to produce a higher-
quality image than is achieved with normal resizing. Resample takes longer to complete than Resize.



Add Text Dialog Box

1. Enter the text that you want to add to the image.
2. To change font attributes, such as name, style, effect and color, click on the Font attributes… 

button.
3. Select the position where the text will be added. You can click on the thumbnail image to select a 

position.
4. Click on the OK button.



The Colors Menu

Brightnetss/Contrast
Brightens or darkens the entire image, or increases or decreases the range of luminance (contrast) 
within the image.

Grey Scale
Converts the image to greyscale, replacing the colors in the image with greys of equal luminance. The 
effect is similar to a black-and-white photograph. Converting a 16 million color image to greyscale 
automatically reduces it to 256 colors.

Invert Colors
Replaces each color in the image with its opposite. The effect is similar to a photographic negative.

Decrease to 2/16/256 Colors
Decreases the number of colors in the image.



Adjust Brightness/Contrast

1. Enter the amout to change the brightness/contrast. Valid values are -1000 to +1000. A postive 
value increases the brightness/contrast of the image. A negative value decreases the 
brightness/contrast of the image.

2. Click on the OK button.

You can click on the Apply button if you want to change the brightness/contrast without closing the dialog 
box. 



Decrease Color Depth

1. Select the palette that you want to use.
2. Select which dithering method to use.
3. Click on the OK button.



The Capture Menu

Area
Allows you to select any rectangular area of the desktop to copy.

Full Screen
Copies the entire screen into IceView 95.

Active Window
Copies the entire active window into IceView 95.

Client Area
Copies the input area of the active window into IceView 95.

Select Hot Key
Selects the hot key used when capturing windows.

See also: How to Capture Images From the Screen



 The Tools Menu

The Set Wallpaper submenu contains the following menu commands:

Centered
Centers the current image on the desktop.

Tiled
Tiles the current image over the desktop.

Stretched
Stretches the image to cover the entire desktop. This command will only be available if Microsoft Plus! 
is installed on your system.

Position
Displays a dialog box allowing you to specify the exact coordinates to where the image will be placed 
on your desktop.

Remove
Removes the desktop wallpaper.

Open With
You can add up to 10 programs to this submenu (such as your favorite painting programs), from the 
Open With tab in the options dialog box. Selecting an application from the Open With submenu will 
send the current image to the application. The first program you add to this submenu will have shortcut
key CTRL+E.

Logo Changer
Presents the logo changer, which allows you to change your Windows startup and shutdown screens 
to any image. Your current logos are displayed in the logo changer. When you right-click on a logo, 
IceView 95 will display a popup menu. The popup menu contains the following commands:

Use Current Image
Uses the current image as the new logo.
View Full Screen
Displays the logo in full screen.
Restore
Restores the original logo.
Restore All
Restores all your original logos.

Your startup and shutdown logos are actually standard Windows Bitmap files, they have 256 colors 
and size 320x400 pixels. IceView 95 eliminates all hassle with replacing logo files with your own 
images. When you select an image as a logo, it is automatically converted to a 320x400x256 Windows
Bitmap and placed at the proper location.

View Thumbnails
Displays a dialog containing every image in the current directory. You can double-click on any image to
open it in IceView 95. If you right-click on an image, a popup menu will appear. It contains the following
commands:

Open
Opens the image in IceView 95.
Open With
Selecting an application from this submenu will send the image to the application.
Wallpaper



This submenu allows you to set the image as a centered, tiled or stretched desktop wallpaper.
Copy
Sends the image to the Windows clipboard.
Information
Displays information about the image.
Move to
Presents a dialog box allowing you to move the image to a different location.
Copy to
Presents a dialog box allowing you to copy the image to a different location.
Delete
Deletes the image.
Rename
Renames the image.
Remove Thumbnail
Removes the selected thumbnail.
Thumbnail Size
Sets the thumbnail size. Changes will take place the next time you run the thumbnail viewer.

Open MS DOS Window
Opens an MS DOS window.

Explore Folder
Explores the current folder with Explorer.

Generate File List
Generates an ASCII text listing for the contents of the file list, including file size, image properties and 
date. The ASCII text file will be named Folder Contents.txt and placed in the folder containing 
ICEVIEW.EXE

Customize Toolbar
Customizes the toolbar. You can add/remove buttons and arrange them as you like.

Options
Displays the options dialog from which you can change various categories of IceView 95 options.



The Help Menu

Contents
Displays the help contents.

How to Use Help
Displays information on how to use the help system.

Keyboard Shortcuts
Displays a list of keyboard shortcuts.

How to Register
Displays information on how to register your copy of IceView 95.

Register Online
Directs your browser to the IceView 95 online registration page.

Visit Home Page
Connects to Mithril Software's web site using the default web browser.

E-Mail Mithril Software
Sends e-mail to Mithril Software. Comments and suggestions are appreciated.

Check for Updates
Checks for new versions of IceView 95 on the web. If there is a new version available, its 
version number, release date and additional features will be displayed in a message box and you will 
have the option to download the update file.

About IceView 95
Displays version number and copyright notice.



What's New in Version 3.2

Version 3.2 - November 22, 1997

Additions/Changes

Added commands to the thumbnail viewer's popup menu allowing you to:

· Set the desktop wallpaper.
· Copy images to the clipboard.
· Move, copy, delete and rename files.
· Remove thumbnails.
· Access the Open With menu.

Other enhancements to the thumbnail viewer:

· The window is now sizable.
· You can select between four different thumbnail sizes.
· Fixed a bug with thumbnails having the wrong proportions.

Enhancements to the slide show editor:

· You can determine whether the slide show should be automatic or manual.
· You can set the background color.



How to Register

The registration fee for IceView 95 is $20 US. When you register IceView 95 you will receive a 
registration key via electronic mail to disable the opening nag screen.

Registration will provide you with:
 A lifetime of free IceView 95 upgrades!
 Membership in the IceView 95 mailing list. 
 Free technical support via e-mail.

Mithril Software has made several options available for registering IceView 95:
 To Register IceView 95 Online via the World Wide Web
 To Register IceView 95 by Credit Card
 To Register IceView 95 by Check

IMPORTANT!    Make sure to include a valid e-mail address with your order. If you don't supply an e-mail 
address, or the e-mail address you supply is invalid, your registration information cannot be sent to you!



To Register IceView 95 Online via the World Wide Web

If you have a credit card, you can register IceView 95 from Mithril Software's web site.

http://www.mithril.d.se

You can go directly to the online registration page by selecting the Register Online command from the 
Help menu.



To Register IceView 95 by Credit Card

You can register IceView 95 with MasterCard, Visa, American Express, or Discover from PsL, a credit 
card order service.

By FAX:

1. Print out and complete the registration form.
2. FAX the completed form to PsL at 713-524-6398.

By E-mail:

Cut and paste this text into an e-mail message, fill in the blanks and send it to PsL at 
30110@pslweb.com.

By Postal Mail:

1. Print out and complete the registration form.
2. Mail the form to PsL at P.O. Box 35705, Houston, TX 77235-5705 USA.

The above numbers are for credit card orders only. Mithril Software cannot be reached at these numbers.

Any questions about the status of the shipment of the order, refunds, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, non-credit card orders, etc., must be 
directed to support@mithril.d.se.

PsL will notify us the day of your order and we will send you registration information via electronic mail. 



To Register IceView 95 by Check

1. Print out and complete the registration form.
2. Mail the form along with a check or money order for $20 US or 150 SEK to:

Mithril Software
Skogshall
635 20 Eskilstuna
Sweden

Checks must be made payable to Mithril Software.



Name:
Company:
Address:
City:
State:
Zip Code:
Country:
E-Mail:

Credit Card:
[    ] MasterCard 
[    ] VISA 
[    ] AMEX 
[    ] Discover

Credit Card Number:
Credit Card Name:
Expiration Date:

Product number for IceView 95: 30110



IceView 95 Registration Form

          Name: _____________________________ Date: _______________

Company: _________________________________________________

    Address: _________________________________________________

                  City: _________________________________________________

              State: ______________________ Zip Code: __________________

      Country: _________________________________________________

          Phone: _________________________________________________

E-Mail address: _____________________________________________

Any comments or suggestions? 

__________________________________________________________

__________________________________________________________

__________________________________________________________

__________________________________________________________



IceView 95 Registration Form

          Name: _____________________________ Date: _______________

Company: _________________________________________________

    Address: _________________________________________________

                  City: _________________________________________________

              State: ______________________ Zip Code: __________________

      Country: _________________________________________________

          Phone: _________________________________________________

E-Mail address: _____________________________________________

Credit card:    [    ] MasterCard [    ] VISA [    ] AMEX [    ] Discover

Credit card number: ___________________________________________

Expiration date: ______________________________________________

Name on card: _______________________________________________

Product number for IceView 95: 30110



Add/Edit Dialog Box

Command line
Here you should enter the path to the program you want to add to the Open With menu. Type in a path 
or click on the … to browse your system for a program to add.

Menu caption
Specifies the name that will appear in the menu for the program you are adding.



How to Run a Slide Show

1. Go to a folder containing at least two images.

2. Click on . Click again to stop.

· The slide show will stop automatically if you click on  or 
.

· If IceView 95 is minimized, or a dialog box is displayed, the slide show will be paused.



How to Capture Images From the Screen

1. Select the hot key that will activate the capture by selecting Select Hot key from the 
Capture menu. The default hot key is F11.

2. If you are copying part of an application, start the application. If you want to copy the whole 
screen, arrange the open windows as you want them to appear in the captured image.

3. Make IceView 95 the active application.

4. Select either Area, Full Screen, Active Window or Client Area from the Capture menu. IceView 95
will minimize automatically. If you selected Active Window or Client Area, activate the window that
you want to capture.

5. Activate the capture by pressing the selected hot key.

6. What happens next depends on which type of capture you are creating. If you are capturing the 
full screen, a client area or a window, IceView 95 will copy the captured screen area into the 
image window. If you are capturing an area, you must specify the area you want to capture with 
the mouse. When you release the mouse button, the selected area will be copied into the image 
window.



How to View an Image Full Screen

Click on . Alternatively, you may press the Enter key or CTRL+F.

· You can display the next/previous image in full screen mode by pressing the 
Page Down/Page Up keys.

· To return to the window, you can either press the ESC key, the Enter key or the right mouse 
button.



How to Create a New Instance of the Program

You can create a new instance of IceView 95 by pressing CTRL+N.



How to Set the Desktop Wallpaper

1. Open the image you want as your new desktop wallpaper.
2. Choose Set Wallpaper from the Tools menu and select either Centered, Tiled, Stretched or 

Position from the submenu. 

· Centered will center the image on the desktop.
· Tiled will tile the image over the desktop.
· Stretched will stretch the image to cover the entire desktop. This command will only be available 

if you have Microsoft Plus! installed.
· Position allows you to specify the exact coordinates to where the image will be placed on your 

desktop.
· To remove the desktop wallpaper, select Remove from the Set Wallpaper submenu, or press 

ALT+W.



How to Manage Files

Using Dialog Boxes:

Moving
1. Open an image.
2. Select Move to from the File menu, or hit F7.
3. Select a destination path from the list, or type in a new one, or click on Browse…
4. Click on the OK button.

Copying
1. Open an image.
2. Select Copy to from the File menu, or hit F8.
3. Select a destination path from the list, or type in a new one, or click on Browse…
4. Click on the OK button.

Deleting
1. Open an image.
1. Select Delete from the File menu, or hit the Delete key. A confirmation box appears if the 

"Confirm delete/overwrite" option is selected. If you want to delete a file permanently, hit 
Shift+Del.

1. Click on OK to delete the file, or Cancel to stop.

Renaming
1. Open an image.
2. Select Rename from the File menu, or hit F2.
3. Enter the new filename.
4. Click on the OK button.

Using OLE Drag And Drop:

You can move and copy files using OLE drag and drop, from the Browser. Instructions:

1. Right click on a file in the Browser.
2. Drag the file and drop it onto or into any folder in Explorer. A popup menu is displayed. Select 

Copy Here to copy the file, select Move Here to move the file.



How to Associate IceView 95 With Images
You can associate IceView 95 with images. This allows you to open an image by double-clicking on it in 
Explorer. To associate some or all image files with IceView 95, follow these steps.

1. Click on     to bring up the Options dialog box.
2. Click on the Associations tab.
3. Check off the file types you would like to associate with IceView 95. Click on the Select All button 
to select all file types. Click on the Select None button if you do not wish to have any file types associated 
with IceView 95.
4. Click on OK.



How to Set Options

1. Click on . An options dialog box comes up.
2. Click on the Help button or press F1 to get information about the options.
3. Set the options.
4. Click on OK to save the options.



Click here to open a slide show script to modify.



Click on this button to save the current slide show script.



This button allows you to select another slide show script to append to the current script.



Click here to add the selected files in the file list to the slide show. Note: You can also add files by double-
clicking on the filename in the file list.



Adds all files in the file list to the slide show.



Removes the selected files from the slide show. Note: You can also remove files by double-clicking on the
filename.



Removes all files from the slide show.



This button closes the slide show editor.



Click on this button to remove all duplicated files in the current slide show, if any.



Click here to remove files from the slide show that doesn't exist.



This is a file list. It displays all images in the current folder. Double-click on a file to add it to the slide 
show. The file list allows multiple selections.



Use this control to change folders.



A list of the files in the current slide show. To remove a file, double-click on it.



Use this control to change to another drive.



If this check box is selected, IceView 95 will display a preview of the currently selected image.



If the Show preview option is selected, a preview of the currently selected image will appear here.



Determines the delay for the current slide show (how many seconds IceView 95 will pause in the slide 
show before showing the next image).



This option determines the sequence in which to display images in the slide show.



If you want IceView 95 to play a mide file or a wave file during this slide show, enter the path to the file 
here, or click on the … button.



Determines the slide show type.
Automatic
The next image will automatically be displayed after a certain amount of time.
Manual
You can view the next/previous image in the slide show by pressing the Page Down/Page Up keys.



Click on this frame to change the background color for the current slide show. 






